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LESSON 1 -  
USING SIMPLE QUERIES  

In this lesson, you will learn how to: 

• Use queries and RecordSets  

• Use the Simple Query Wizard  

• Create a query in Design view  

• Open a query  

• Add a table to a query  

• Join tables in a query  

• Run a query  



Lesson 1 - Using Simple Queries Creating Queries Using Access 2000 

Page 2 US Senate Office of Education and Training
 

USING QUERIES AND RECORDSETS 

 Discussion 
A query is a question about information in a table or tables. You can use queries to 
view and analyze data or as a basis for forms and reports. Queries are commonly used 
to display fields from related tables and enable you to control not only what records 
display, but also what fields display. For example, you may want a list of the contacts 
and telephone numbers for a particular region to give to one of your sales 
representatives. By creating what is called a select query, you can limit the records to 
the appropriate region and limit the fields to the contact name and telephone number.  
 
A query does not contain data. Rather, it is a set of instructions. Access uses these 
instructions to select and display the appropriate records in a table. Therefore, when 
you add data to a table, you do not have to update the query. The query always 
considers all the data in the table. If the new records meet the conditions of the query, 
they will be included when the query results appear. 
 
When you open or run a query, a RecordSet appears. A RecordSet contains all the 
fields and records that meet the conditions of the query. While the RecordSet is not a 
table, it can be used under certain conditions to add and edit records in tables. 
 

USING THE SIMPLE QUERY WIZARD 

 Discussion 
Access provides a Simple Query Wizard that guides you through the steps to create a 
basic select query. When you use the Simple Query Wizard, you select the table you 
want to use and the fields you want to display in the query. In the last step, you name 
the query and then choose whether or not to display the results (the RecordSet) of the 
query or if you want to go to Design view to change the design of the query. 



Creating Queries Using Access 2000 Lesson 1 - Using Simple Queries 

US Senate Office of Education and Training Page 3
 

 
The Simple Query Wizard 

 
  

 
You can also activate the Simple Query Wizard by double-
clicking the Create query by using wizard option in the 
Queries object list in the Database window, or by selecting 
the Insert menu and then selecting the Query command. 

  
 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Select the New button  on the Database window toolbar. 

4. Select Simple Query Wizard. 

5. Select OK. 

6. Select the Tables/Queries list. 

7. Select the table or query you want to use as the basis for the query. 

8. Add the field(s) you want to display in the query from the Available 
Fields list box. 

9. Select Next. 
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10. Type a name for the query. 

11. Select Finish. 

 

CREATING A QUERY IN DESIGN VIEW 

 Discussion 
You can create a query in Design view. This option gives you the most flexibility in 
designing a select query. It allows you to add criteria to select records and sort the 
resulting RecordSet. 
 
When you create a query in Design view, you use the design grid to set up the query. 
The field list of the table you want to use in the query appears in the top pane of 
Design view. You add the fields you want to use in the query to the design grid in the 
bottom pane of Design view, along with any sort orders or criteria for selecting 
records. 

 
Creating a query in Design view 

 
  

 
You can also add fields by double-clicking the name of the 
field in the field list or by clicking in the desired column in the 
Field row of the design grid to display an arrow. When you 
click the arrow, a list of available fields appears from which 
you can select a field. 

  

 
You can also create a query in Design view by double-
clicking the Create query in Design view option in the 
Queries object list in the Database window. 
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You can add all the fields by dragging the asterisk (*) at the 
top of the field list to the Field row in the design grid. 

  
 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Click the New button  on the Database window toolbar. 

4. Select Design View. 

5. Select OK. 

6. Select a table to add it to the query. 

7. Select Close to close the Show Table dialog box. 

8. Select the first field you want to add to the query. 

9. Drag the field to the desired column in the Field row in the design 
grid. 

10. Add other fields to the query as desired. 

11. Click the Save button . 

12. Type a name for the query. 

13. Select OK. 

 

OPENING A QUERY 

 Discussion 
When you open a query, Access runs the instructions in the query and displays the 
resulting RecordSet in Datasheet view. If you have added records since the last time 
you ran a particular query, the new records will appear if they meet the query criteria. 
 

  

 
You can also open a query by double-clicking the query name 
in the Queries object list in the Database window, or by right-
clicking the query name and then selecting the Open 
command. 
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 Steps 

1. Open the desired database. 

2. Select the Queries object list. 

3. Select the name of the query you want to open. 

4. Select the Open button  on the Database window 
toolbar. 

 

ADDING A TABLE TO A QUERY 

 Discussion 
You can use more than one table in a query. The tables must be joined in order for the 
query to give accurate results. If they are not joined, you can create a join in the top 
pane of Design view. 
 
When you add more than one table, the field lists appear in the top pane of Design 
view. If the tables are already related, join lines appear automatically. 
 
Once you have added a table to the query, you can then add fields from the field list to 
the design grid. The second row in the design grid is the Table row, which indicates 
from which table the field originates. 
 
When you open Design view to design a new query, the Show Table dialog box opens 
automatically so that you can add multiple tables. However, when you open Design 
view to modify an existing query design (i.e., to add a table), you must open the Show 
Table dialog box manually. 
 

  

 
You can also open the Show Table dialog box by right-
clicking in the top pane of Design view and then selecting the 
Show Table command, or by selecting the Query menu and 
then selecting the Show Table command. 
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 Steps 

1. Open the desired database. 

2. Select the Queries object list. 

3. Select the name of the query to which you want to add a table. 

4. Select the Design button  on the Database window 
toolbar. 

5. Click the Show Table button  on the Query Design toolbar. 

6. Select the name of the table you want to add to the query. 

7. Select Close to close the Show Table dialog box. 

 

JOINING TABLES IN A QUERY 

 Discussion 
If you have multiple tables in a query, the tables must be joined in order for the query 
to give accurate and meaningful results. If Access does not know how to relate the 
data between tables, it displays every combination of data between the two tables. For 
example, if one table has 20 records and the other has 5, then the RecordSet will 
contain 100 records and the results are virtually meaningless. 
 
If the relationships have already been defined in the Relationships window, join lines 
between the field lists display automatically in Design view. Therefore, if you add a 
related table to a query, a join line appears automatically. Access also automatically 
creates a join if there is a field with the same name in both tables. If there is no 
predefined relationship or fields with the same name, you must create the relationship. 
 
The join type defined in the relationship is particularly important to queries. The 
default type is an inner join in which records are only included in the RecordSet if 
there is matching data in the join fields for both tables. You can also create an outer 
join in which all the records from the “one” table appear, even if there is no matching 
data in the “many” table. 



Lesson 1 - Using Simple Queries Creating Queries Using Access 2000 

Page 8 US Senate Office of Education and Training
 

 
Joining tables in a query 

 
  

 
Joins that you define in a query do not appear in the 
Relationships window. 

  

 
You can remove a join line in a query by right-clicking the 
desired join line and then selecting the Delete command. 

  

 
You can also open the Join Properties dialog box by right-
clicking the join line and then selecting the Join Properties 
command, or by selecting the View menu and then selecting 
the Join Properties command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Add a second table to the query, if necessary. 

4. Select the join field in the field list of the first table. 

5. Drag the field on top of the matching field in the field list of the 
second table. 

6. Double-click the join line. 
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7. Select the desired join type. 

8. Select OK. 

 

RUNNING A QUERY 

 Discussion 
You can run a query directly from Design view to display the RecordSet. This option 
is useful if you want to test the design of the query to see if the resulting RecordSet 
contains the information you need. 
 
Running a query does not save the design of the query. If you close the RecordSet 
after running a query, a message box opens, asking if you want to save the changes.  
 

  

 
You can also run a query by selecting the Query menu and 
then selecting the Run command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the query in Design view. 

3. Click the Run button  on the Query Design toolbar. 

 





 

 

LESSON 2 -  
MODIFYING QUERY RESULTS  

In this lesson, you will learn how to: 

• Sort a query  

• Add criteria to a query  

• Hide a field in a query  

• Add a record using a query  

• Print a query  
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SORTING A QUERY 

 Discussion 
When you run a query, the records in the RecordSet appear in the same order in which 
they appear in the table. You can sort the records by either sorting the RecordSet or 
assigning a sort order in the query design. You can sort the RecordSet just as you 
would sort a table. However, you must do this every time you run the query. If you 
assign the sort order in the query design, Access performs the sort automatically each 
time you run the query. 

 
Sorting a query 

 
  

 
You can sort on more than one field; for example, you can sort 
by region and then by states within the region. To sort on more 
than one field, the Region field must be to the left of the State 
field in the query design grid, since Access sorts from left to 
right in the design grid. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Select the Sort row under the field by which you want to sort. 

4. Select the Sort list. 
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5. Select Ascending or Descending. 

 

ADDING CRITERIA TO A QUERY 

 Discussion 
You can enter data in the Criteria row of the query design grid to restrict the number 
of records that are returned in a query. 
 
To select records that meet a single value, you enter the value in the Criteria row 
under the appropriate field. Access automatically inserts quotation marks (“ ”) around 
alphanumeric entries and number symbols (#) around date entries. If the entry is 
numeric, the number appears without quotation marks. When you run the query, only 
those records with values that match the criteria appear in the RecordSet. 

 
A RecordSet with specified criteria 

 
  

 
When entering a field name, it must be entered in the same 
way as it appears in the table. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 
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3. Select the Criteria row under the desired field. 

4. Type the value for the criteria. 

5. Press [Enter]. 

 

HIDING A FIELD IN A QUERY 

 Discussion 
You can use a field to select records that meet a certain criteria without displaying the 
field in the RecordSet. This option is useful when all the records meet the same 
specified criteria and, therefore, you do not need the field to appear. 
 
For example, you may want to create a query to display customers in the Southeast 
region. Therefore, you must add the Region field to the query in order to enter the 
criteria to select only the Southeast region. However, you might not want the field to 
appear in the RecordSet because you know that all the data in the Region field is the 
same (Southeast). In this case, you may want to hide the field you used for the 
criteria. 
 
The design grid includes a Show row with a check box for each field. If the check box 
is selected, the field will appear in the RecordSet. If the check box is deselected, the 
field will be hidden in the RecordSet. All the Show field check boxes are selected by 
default. 
 

 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Deselect the check box in the Show row under the field you want to 
hide. 

 

ADDING A RECORD USING A QUERY 

 Discussion 
You can use a query to update records in related tables. When you enter information 
into the join field for a primary table, Access automatically locates the corresponding 
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information in the related table and enters it into the record. For example, the Orders 
and Customers tables are related. When you enter the customer ID number in the 
appropriate field in the Orders table, Access completes the customer name and 
address information automatically through the relationship with the Customers table. 
 
You can always edit information in queries based on a single table. In queries based 
on related tables, Access must be able to determine the relationship type (i.e., one-to-
one or one-to-many), or you cannot edit information. In queries with tables that have a 
one-to-one relationship, you can always edit data. In queries with tables that have a 
one-to-many relationship, you may not be able to edit data at times. For example, this 
can happen if the join field from the “many” table is not in the query, since Access 
cannot create new records in the “many” table. For example, Access cannot create 
new orders for a customer if the query is based on the Customers table unless the 
Customer ID field from the Orders table is included in the query. 
 

  

 
You can use Help to get more details about when you can 
update data in a query containing tables that have a one-to-
many relationship. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired query in Datasheet view. 

3. Click the New Record button  on the Query Datasheet 
toolbar. 

4. Type the necessary data in the first field. 

5. Move to the next field. 

6. Type the necessary data in the second field. 

7. Move to the next field. 

8. Continue to add data as necessary. 

9. Save the current record. 
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PRINTING A QUERY 

 Discussion 
You can print the RecordSet resulting from a query. You can print it after you run a 
query, while it appears on the screen, or you can save time by printing it directly from 
the Database window. If you print the RecordSet from the Database window, Access 
runs the query and sends the results to the printer, rather than to the screen. 
 

 Steps 

1. Open the desired database. 

2. Select the Queries object list. 

3. Select the name of the query you want to print. 

4. Click the Print button  on the Database toolbar. 

 



 

 

LESSON 3 -  
USING OPERATORS IN QUERIES  

In this lesson, you will learn how to: 

• Use comparison operators  

• Use an And condition  

• Use an Or condition  

• Use the Between And operator  

• Use a wildcard character  
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USING COMPARISON OPERATORS 

 Discussion 
You can enter criteria in the Criteria row of the query design grid in order to select 
specific records. The simplest criteria requires that records match a single value to be 
included in the RecordSet. 
 
You can also use comparison operators to select a specific group of records in a table. 
For example, if you want to find all customers with credit limits less than $1000, or all 
customers with a contract date on or before January 1997, you can write an expression 
that defines the criteria using a combination of comparison operators and field values, 
such as <1000 or <=1/1/97. Comparison operators are symbols that represent 
conditions recognized by Access. The available comparison operators are listed in the 
following table: 

 
Operator Description 

< less than 
<= less than or equal to 
> greater than 

>= greater than or equal to 
= equal to 

<> not equal to 
Not reverses logic 

 
You can use a comparison operator to compare a specified value with all the values in 
a field. When you run the query, only the records with values meeting the criteria you 
specify appear in the RecordSet. 
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Using a comparison operator 

 
  

 
Access automatically inserts number symbols (#) around date 
values and quotation marks (“ ”) around alphanumeric values. 
Access does not insert any symbols or characters around 
numeric values. 

  

 
You can also specify criteria using the Expression Builder by 
selecting the desired Criteria row under the appropriate field 
and clicking the Build button on the Query Design toolbar, or 
by right-clicking in the Criteria row and then selecting the 
Build command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Select the Criteria row under the appropriate field. 

4. Type a comparison operator and the value for the criteria.  

5. Press [Enter]. 
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USING AN AND CONDITION 

 Discussion 
Many times, a query requires more than one condition to obtain the desired result. For 
example, if you want to find all customers in PA with sales to date over $10,000, you 
would need two conditions: State=PA and Sales to Date>10000. The records must 
meet both conditions in order to be included in the RecordSet. To combine two 
criteria in this way, you use the And logical operator. 
 
You can use the And operator in a single field or in different fields. In a single field, 
you can use the And operator to find records that fall into a range. For example, to 
find customers whose contract dates fall between 9/1/99 and 9/30/99, you type both 
criteria on a single line in the Criteria row under the appropriate field (i.e., >=9/1/99 
And <=9/30/99 in the Contract Date field). 
 
The And operator also allows you to impose conditions in two different fields. For 
example, to find customers in PA with sales to date over $10,000, you type each 
criterion on a single line in the Criteria row under the appropriate fields (i.e., =PA in 
the State/Province field and >10000 in the Sales to Date field). 
 

  

 
Criteria across columns create an And condition, whereas 
criteria down rows create an Or condition. 

  

 
You can also specify criteria using the Expression Builder by 
selecting the desired Criteria row under the appropriate field 
and clicking the Build button on the Query Design toolbar, or 
by right-clicking in the Criteria row and then selecting the 
Build command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Select the Criteria row under the desired field. 

4. Type the first criterion. 

5. Type the And operator and the second criterion in the Criteria row 
under the same field or type the second criterion in the Criteria row 
under a different field. 

6. Press [Enter]. 
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USING AN OR CONDITION 

 Discussion 
Many times, a query requires more than one condition to obtain the desired result. For 
example, if you want to find all customers in PA or all customers with sales to date 
over $10,000, you would need two conditions: State=PA as well as Sales to 
Date>10000. The records only need to meet one of the conditions in order to be 
included in the RecordSet. To combine two criteria in this way, you use the Or logical 
operator. 
 
You can use the Or operator in a single field or in different fields. In a single field, 
you type the criteria on two separate lines under the same field. In different fields, you 
type the criteria on two separate lines under the appropriate fields. For example, to 
find all customers with contract dates on or before 1/1/99 or credit limits above 
$3,000, you type <=1/1/99 in the Criteria row under the Contract Date field and 
>3000 in the or row under the Credit Limit field. 

 
Using an Or condition 

 
  

 
Criteria across columns create an And condition, whereas 
criteria down rows create an Or condition. 

  

 
You can also specify criteria using the Expression Builder by 
selecting the desired Criteria row under the appropriate field 
and clicking the Build button on the Query Design toolbar, or 
by right-clicking in the Criteria row and then selecting the 
Build command. 
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 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Select the Criteria row under the desired field. 

4. Type the first criterion. 

5. Select the or row under the same field. 

6. Type the second criterion. 

7. Press [Enter]. 

 

USING THE BETWEEN AND OPERATOR 

 Discussion 
You can use the Between And operator in a query to find data that is between two 
values. You can use this operator with a text, numeric, or date field. For example, to 
find all records of customers with credit limits between 1000 and 2000, you would 
enter Between 1000 And 2000 in the Criteria row under the Credit Limit field. 
 

  

 
The values specified in the Between And operator are 
included in the RecordSet. 

  

 
You can also specify criteria using the Expression Builder by 
selecting the desired Criteria row under the appropriate field 
and clicking the Build button on the Query Design toolbar, or 
by right-clicking in the Criteria row and then selecting the 
Build command. 

  
 

  

 
Spaces must be included between the criteria and the words 
Between and And. If you do not include spaces, a message 
box opens, stating that there is a Data type mismatch in 
criteria expression. 
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 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Select the Criteria row under the desired field. 

4. Type the Between And operator and the criteria. 

5. Press [Enter]. 

 

USING A WILDCARD CHARACTER 

 Discussion 
Wildcard characters are used in a query to find records when the criteria contains a 
pattern (such as all last names beginning with M) or is only partly known (such as the 
proper spelling—Kline or Klein). Wildcards take the place of one or several letters in 
a Text field or numbers in a Date/Time field. 
 
The two most common wildcards are listed in the following table: 

 
Wildcard What It 

Represents 
Example 

? Any single letter 
or number 

Sm?th finds Smith and Smyth, 
whereas ?andy finds Sandy, Randy, 
etc. 

* One or more 
letters or 
numbers 

M* finds all records that start with 
M; 8/*/99 finds all dates in August, 
1999; and *ball* finds all records 
that have the word ball anywhere in 
the field 
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Using a wildcard character 

 
  

 
Wildcards are not case-sensitive (for example, *ill finds Bill 
and bill). 

  

 
When you use wildcard characters (? and *), Access 
automatically inserts the word Like before the criteria and 
quotation marks (“ ”) around the criteria. 

  

 
You can also specify criteria using the Expression Builder by 
selecting the desired Criteria row under the appropriate field 
and clicking the Build button on the Query Design toolbar, or 
by right-clicking in the Criteria row and then selecting the 
Build command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Select the Criteria row under the desired field. 

4. Type the criteria with the appropriate wildcards. 

5. Press [Enter]. 

 



 

 

LESSON 4 -  
DESIGNING ADVANCED QUERIES  

In this lesson, you will learn how to: 

• Set top values in a query  

• Create a calculated field  

• Create a function query  

• Create a parameter query  

• Create a concatenation in a query  

• Use multiple tables in a query  

• Filter a query  
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SETTING TOP VALUES IN A QUERY 

 Discussion 
You can limit the results of a query so that only the highest or lowest values for a field 
appear in a RecordSet. For example, you can set the top values of a Quantity Sold 
field to 10 to find the top ten best selling products. You can limit the number of 
records to a specific number or a percentage of all records being queried (i.e. top 
25%). The field for which you are setting the top or bottom values must be sorted. If 
the field is sorted in descending order (Z to A, 9 to 0), the top values will be found. If 
the field is sorted in ascending order (A to Z, 0 to 9), the bottom values will be found. 

 
Setting top values in a query 

 
  

 
If other fields in the query are sorted, they must appear to the 
right of the field for which you are finding top or bottom 
values in the design grid. 

  

 
You can also type a value into the Top Values text box on the 
Query Design toolbar. 
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 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Select the Sort row under the desired field. 

4. Select the Sort list. 

5. Select the desired sort order. 

6. Select the Top Values list on the Query Design toolbar. 

7. Select the desired top value. 

 

CREATING A CALCULATED FIELD 

 Discussion 
You may want to use field values in a table to calculate new values, such as 
multiplying the value in the Quantity field by the value in the Price field to calculate 
the total sales. Access allows you to use expressions to calculate new field values. The 
expression can also include a single field, which has a value that needs to be adjusted, 
such as doubling a Wholesale Price field to calculate values for a Retail Price field. 
In expressions, field names are enclosed in square brackets ([ ]); numbers are not. For 
example, to calculate 20% of sales and display the results in a column you want to 
name Commission, you would enter Commission:.2*[Sales] in the design grid. The 
colon is used to separate the column name from the expression. 
 
You create calculated fields in queries. You can also use criteria to remove 
nonessential records, thereby allowing the query to run faster. The results can then be 
used to generate a report. 
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Calculating a field 

 
  

 
The field names entered in brackets ([ ]) must be the same as 
the field names in the table. 

  

 
You can also specify criteria using the Expression Builder by 
selecting the desired Criteria row under the appropriate field 
and clicking the Build button on the Query Design toolbar, or 
by right-clicking in the Criteria row and then selecting the 
Build command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Select the Field row in the first blank column. 

4. Type the new field name and a colon (:). 

5. Type the expression required to perform the calculation. 

6. Press [Enter]. 
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CREATING A FUNCTION QUERY 

 Discussion 
Access allows you to create a query that groups records by a selected field and applies 
a function that calculates values on other fields in the query according to your needs. 
For example, you can group records in a table by state and then select the Count 
function to find out how many customers (records) are in each state (field). You can 
also group by customer name (field) and calculate the Sum of each customer’s orders 
(record values). 
 
There are several types of functions from which you can choose. The most commonly 
used functions are listed in the following table: 

 
Function Description 
Sum Sums the values in the calculated field 
Average Finds the average value of the calculated field 
Count Counts the number of records in the calculated field 
Max Finds the highest value in the calculated field 
Min Finds the lowest value in the calculated field 

 
 

  

 
You can perform more than one calculation on a field by 
adding the field to the design grid a second time. For example, 
you can group by weekly sales and find both the minimum and 
maximum values. 

  

 
You can also add a Total row by right-clicking in the design 
grid and then selecting the Totals command. 

  
 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Select the New button  on the Database window toolbar. 

4. Select Design View. 

5. Select OK. 
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6. Select the name of the table you want to add to the query. 

7. Select Add. 

8. Select Close to close the Show Table dialog box. 

9. Select the field by which you want to group. 

10. Select the field you want to calculate. 

11. Select the View menu. 

12. Select the Totals command. 

13. Select the Total row under the field you want to calculate. 

14. Select the Total list. 

15. Select the desired function. 

 

CREATING A PARAMETER QUERY 

 Discussion 
If you want to run a query with different criteria each time, you can create a parameter 
query. A parameter query is a query that prompts the user for information when the 
query is run. Access then uses the information as the criteria and runs the query. The 
resulting RecordSet only includes those records that meet the criteria. This option 
allows you to avoid displaying the query in Design view each time you want to 
change the criteria. 
 
You enter the text that will display in the prompt in the Criteria row under the 
appropriate field in the design grid, followed by a colon (:) and enclosed in square 
brackets ([ ]). You can set up a parameter query to prompt the user for more than one 
piece of information as well. 
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Creating a parameter query 

 

 Steps 

1. Open the desired database. 

2. Open the desired query in Design view. 

3. Select the Criteria row under the desired field. 

4. Type the desired text for the prompt, followed by a colon (:) and 
enclosed in square brackets ([ ]). 

5. Press [Enter]. 

 

CREATING A CONCATENATION IN A QUERY 

 Discussion 
Access allows you to combine two or more fields into one field. This process, known 
as concatenation, enables you to add field name text strings to one another. The text 
strings can follow each other with or without spaces. You can add other characters 
between the text strings if needed. For example, you can combine the individual City, 
State, and Postal Code fields into one field called Address. You can have the comma 
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and space characters appear between the field text strings. This concatenation process 
can be performed by creating a query to combine two or more fields. 
 
When typing expressions for concatenation, the first part of the expression defines the 
name of the new field. The second part of the expression defines the fields which are 
to be concatenated. These field names must be surrounded by brackets. The 
ampersand (&) appears between the field name brackets. Any additional characters 
that are to appear between the fields are surrounded by double quotes.  For example, 
the expression Names: [First Name] &" - "&[Last Name] creates a new field called 
Names. The new field contains the first name and last name separated by a space, a 
hyphen, and a space. 

 
Creating a concatenation in a query 

 
  

 
You can also use the concatenation process when creating text 
strings in forms or reports. 

  

 
You can also specify a concatenation expression using the 
Expression Builder by selecting the desired field and clicking 
the Build button on the Query Design toolbar, or by right-
clicking in the Criteria row and then selecting the Build 
command. 

  
 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Select the New button  on the Database window toolbar. 
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4. Select Design View. 

5. Select OK. 

6. Select the name of the table you want to add to the query. 

7. Select Add. 

8. Select Close to close the Show Table dialog box. 

9. Type the first part of the concatenation expression that names the 
new field. 

10. Type the second part of the concatenation expression that defines the 
fields to be combined along with any separation characters. 

 

USING MULTIPLE TABLES IN A QUERY 

 Discussion 
There may be instances when you need to add more than one table or query to a 
query. In order to do this, you need to ensure that the field lists are joined to each 
other with  a join line so that Access knows how to connect the information. 
 
If tables in a query are not joined to one another, Access does not know which records 
are associated with which, so every combination of records between the two tables 
would appear in the query. Therefore, if each table had 50 records, the query's results 
would contain 2500 records (50x50), thereby rendering useless results. 
 
If you previously created a relationship between tables in the Relationship window, 
Access automatically displays join lines when you add related tables in query Design 
view. If you have not previously created relationships, Access automatically creates 
joins if tables were added to a query as long as the tables each have a field with the 
same or compatible data type and one of the join fields is a primary key. If tables 
added to the query do not include any fields that can be joined, you have to add one or 
more extra tables or queries to serve solely as a bridge between the tables containing 
the data you want to use. 
 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Select the New button  on the Database window toolbar. 
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4. Select Design View. 

5. Select OK. 

6. Select the name of the table you want to add to the query. 

7. Select Add. 

8. Select the name of the second table you want to add to the query. 

9. Select Add. 

10. Select Close to close the Show Table dialog box. 

11. Add the first field you want to add to the query to the first column of 
the Field row in the design grid. 

12. Add the second field you want to add to the query to the second 
column of the Field row in the design grid. 

 

FILTERING A QUERY 

 Discussion 
You can apply filters to queries in the same way you apply filters to a table or form. 
Since the data you want to filter sometimes appears in two or more tables, you might 
need to create a multiple table query. Once the query is created, you can apply a filter 
to temporarily isolate the records that you want to view. 
 
The Filter By Selection feature allows you to create a filter by selecting the field 
containing the information you want to isolate. Conversely, the Filter By Form 
feature allows you to create a filter by entering the values you want to isolate. In 
addition, the Filter By Form feature allows you to select multiple fields. 
 

 Steps 

1. Open the desired database. 

2. Open the desired query in Datasheet view. 

3. Select the field containing the data you want to filter. 

4. Select the desired filter button on the Query Datasheet toolbar. 

5. If you select the Filter By Form option, select the desired field 
options. 

6. If you select the Filter By Form option, select Apply filter. 
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LESSON 5 -  
CREATING ACTION QUERIES  

In this lesson, you will learn how to: 

• Create a make-table query  

• Create an update query  

• Create an append query  

• Create a delete query  
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CREATING A MAKE-TABLE QUERY 

 Discussion 
A make-table query creates a new table consisting of data from existing tables and 
queries. Make-table queries have many uses. The new table can be a duplicate of an 
existing table and serve as a backup for the data. The backup can then be used to store 
old records that can then be deleted from the current table. 
 
Make-table queries can create a compact version of an existing table, displaying only 
the fields you need to see. They can also bring fields from many tables into one table, 
making reports and queries on the single table run faster. 
 
You can limit both records and fields in a new table. If you use criteria in a make-
table query, only those records that meet the criteria will be added to the new table. 
 

  

 
The fields that make up the created table retain only the data 
type and field size properties assigned to them in the source 
tables. 

  

 
You can also create a make-table query by right-clicking in 
the top pane of Design view and then selecting the Make-
Table command. 

  
 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Select the New button  on the Database window toolbar. 

4. Select Design View. 

5. Select OK. 

6. Select the name of the table or query you want to add to the query. 

7. Select Add. 

8. Select Close to close the Show Table dialog box. 

9. Add the first field you want to add to the query to the first column of 
the Field row in the design grid. 
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10. Add other fields to the query as desired. 

11. Select the Criteria row under the desired field. 

12. Type the desired criteria. 

13. Select the Query menu. 

14. Select the Make-Table Query command. 

15. Type a table name. 

16. Select OK. 

17. Run the query. 

18. Select Yes. 

 

CREATING AN UPDATE QUERY 

 Discussion 
You can use an update query to change the values of data in an existing table. Update 
queries save time by updating a large number of records in a table at once. For 
example, you can use an update query to increase the values in a Unit Price field by 
10%. 
 
You can also create a new field in the table and use an update query to provide the 
values for the field based on a calculation. For example, you could create a Sale Price 
field in a table and then use an update query to add the values to the field based on 
75% of the Unit Price field. 
 
If you do not want to update all the records in the table, you can select the records you 
want to update by adding criteria to the query. For example, you can use an update 
query with criteria to increase the unit price on only one line of products, instead of on 
all the products. 
 
In an update query, you do not need to include all the fields from the table in the 
design grid. You only need to include the fields you want to update and the fields you 
want to limit with criteria. 
 

  

 
When you refer to field names in a query, they must be 
enclosed in square brackets ([ ]). 

  

 
You can also create an update query by right-clicking in the 
top pane of Design view and then selecting the Update Query 
command. 
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Running an update query alters the values of field data. Make 
sure that you select the correct records for updating and type 
the correct expression in the Update To row of the design 
grid. 

  
 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Select the New button  on the Database window toolbar. 

4. Select Design View. 

5. Select OK. 

6. Select the name of the table you want to add to the query. 

7. Select Add. 

8. Select Close to close the Show Table dialog box. 

9. Select the Query menu. 

10. Select the Update Query command. 

11. Add the first field you want to update to the first column of the Field 
row in the design grid. 

12. Select the Update To row under the desired field. 

13. Type the expression required to perform the update. 

14. Run the query. 

15. Select Yes. 

 

CREATING AN APPEND QUERY 

 Discussion 
An append query copies records from a table or query and adds them to the end of 
another table. Append queries are useful if you want to transfer data from one table to 
another. You can also use an append query to archive all or part of a table’s contents. 
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For example, you have two tables, Current Orders and Old Orders. You can use an 
append query to copy the records from the Current Orders table to the Old Orders 
table. This query prevents you from having to manually add the records to the Old 
Orders table. 
 
If the fields in both tables have the same names, the data is added automatically to the 
table. If the fields have different names, you must specify the fields to which you want 
to “append” the data. The data is copied to the field(s) indicated in the Append To 
row of the appropriate field(s) in the design grid. 
 
You can also use criteria to select the records you want to append. Only those records 
that meet the criteria are appended to the table. 

 
Creating an append query 

 
  

 
You can also create an append query by right-clicking in the 
top pane of Design view and then selecting the Append 
Query command. 

  
 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Select the New button  on the Database window toolbar. 

4. Select Design View. 

5. Select OK. 
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6. Select the name of the table you want to add to the query. 

7. Select Add. 

8. Select Close to close the Show Table dialog box. 

9. Select the Query menu. 

10. Select the Append Query command. 

11. Type the name of the table to which you want to append data. 

12. Select OK. 

13. Add the first field you want to append to the first column of the 
Field row in the design grid. 

14. Add other fields to the query as desired. 

15. Select the Append To row under the desired unmatched field, if 
necessary. 

16. Select the Append To list. 

17. Select the matching field. 

18. Select the Criteria row under the desired field. 

19. Type the desired criteria. 

20. Run the query. 

21. Select Yes. 

 

CREATING A DELETE QUERY 

 Discussion 
You can use delete queries to maintain the appearance, usefulness, and efficiency of 
tables in a database. When records have been appended or archived to another table, 
or they are simply no longer of use to you, it is a good idea to delete them from the 
table. Deleting records saves disk space and makes tables more efficient. The more 
data in a table, the more time it takes to save, sort, and query. 
 
Delete queries enable you to delete specific groups of records at one time by applying 
criteria to the appropriate fields in a table. You cannot delete data in specific fields 
because a delete query always deletes entire records. 
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Creating a delete query 

 
  

 
You can also create a delete query by right-clicking in the top 
pane of Design view and then selecting the Delete Query 
command. 

  
 

  

 
After you run a delete query, the deleted records are not 
retrievable. Therefore, you should always preview the records 
you are going to delete after you have added the desired 
criteria to the design grid. You can perform this action by 
running a select query. After you confirm that the selected 
records should be deleted, you can run the delete query. A 
delete query only deletes records when you run it. 

  
 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Select the New button  on the Database window toolbar. 

4. Select Design View. 

5. Select OK. 

6. Select the name of the table you want to add to the query. 

7. Select Add. 
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8. Select Close to close the Show Table dialog box. 

9. Add the field(s) you want to add to the query to the appropriate 
column(s) of the Field row in the design grid. 

10. Add the field you want to use to set the criteria to the (?) column of 
the Field row in the design grid. 

11. Select the Criteria row under the desired field. 

12. Type the desired criteria. 

13. Select the Query menu. 

14. Select the Delete Query command. 

15. Run the query. 

16. Select Yes. 

 



 

 

LESSON 6 -  
USING ADVANCED QUERY WIZARDS  

In this lesson, you will learn how to: 

• Use the Crosstab Query Wizard  

• Use the Find Duplicates Query Wizard  

• Use the Find Unmatched Query Wizard  
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USING THE CROSSTAB QUERY WIZARD 

 Discussion 
You can use crosstab queries to group and summarize information and display it in a 
spreadsheet format. Crosstab queries create less repetition of information in the 
datasheet, making it easier to read and analyze the selected field data. The Crosstab 
Query Wizard can help you quickly create a crosstab query. Through a step by step 
process, the Crosstab Query Wizard asks you for information about the tables and 
fields you want in your query. 
 
You need three fields to create a crosstab query. The first field displays its values as 
row headings for the datasheet, the second field displays its values as column 
headings for the datasheet. The third field is the field on which the calculation is 
performed. 
 
For example, crosstab queries can provide information as to how many of each 
product (listed as row headings) are sold by each sales representative (listed as column 
headings). At the intersection of each row and column is the amount of each product 
sold by each sales representative. 

 
The results of a crosstab query 

 
  

 
It is best to select the field with the least amount of values for 
the column headings. This option gives a less cluttered 
appearance when the query results appear. 
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 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Select the New button on the Database window toolbar. 

4. Select Crosstab Query Wizard.  

5. Select OK. 

6. Select the desired table or query from the Which table or query 
contains the fields you want for the crosstab query results? list 
box. 

7. Select Next. 

8. Add the desired field(s) you want to use to provide values for the 
row headings from the Available Fields list box. 

9. Select Next. 

10. Add the desired field(s) you want to use to provide values for the 
column headings from the Which field’s values do you want as 
column headings? list box. 

11. Select Next. 

12. Select the field you want to use to calculate at the intersection point 
from the Fields list box. 

13. Select the desired function from the Functions list box.  

14. Select Next. 

15. Type a name for the query. 

16. Select Finish. 

 

USING THE FIND DUPLICATES QUERY WIZARD 

 Discussion 
The Find Duplicates Query Wizard assists you in designing a query that displays 
duplicate records in tables. This query can be used to group records with like field 
values, such as finding all customers in a particular city. More importantly, there may 
be identical records stored in a table when only one record is necessary. The Find 
Duplicates Query Wizard displays these duplicate records. The unnecessary duplicate 
records can then be deleted from the table. 
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The results of a query using the Find Duplicates Query Wizard 

 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 

3. Select the New button  on the Database window toolbar. 

4. Select Find Duplicates Query Wizard.  

5. Select OK. 

6. Select the table or query on which you want to base the query from 
the list box. 

7. Select Next. 

8. Add the desired field(s) in which you want to find duplicates from 
the Available fields list box. 

9. Select Next. 

10. Add any additional fields you want to show in the query from the 
Available fields list box. 

11. Select Next. 

12. Type a name for the query. 

13. Select Finish. 
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USING THE FIND UNMATCHED QUERY WIZARD 

 Discussion 
You can manage related data in tables using the Find Unmatched Query Wizard. This 
wizard assists you in designing a query that finds records that are “orphans,” meaning 
that there are no records in a related table to which they correspond. For example, 
suppose you delete records from a Customers table containing the names of customers 
who have not placed any orders for more than one year. Two years later, an old 
customer places an order, which is entered into the Orders table. Because these tables 
are likely to be related, having an order without any customer information (such as the 
mailing address) is likely to cause problems. You can use the Find Unmatched Query 
Wizard to display these records and correct the problem by updating the Customers 
table. 

 
The Find Unmatched Query Wizard 

 
  

 
Unmatched records do not occur if referential integrity is 
enforced in the relationship between the two tables. 

  
 

 Steps 

1. Open the desired database. 

2. Display the Queries object list. 
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3. Select the New button  on the Database window toolbar. 

4. Select Find Unmatched Query Wizard.  

5. Select OK. 

6. Select the table or query on which you want to base the query from 
the Which table or query contains records you want in the query 
results? list box. 

7. Select Next. 

8. Select the related table or query from the Which table or query 
contains the related records? list box. 

9. Select Next. 

10. Select the matching field in the Fields in '<table or query name>' 
list box as necessary. 

11. Select the matching field in the Fields in '<table or query name>' 
list box as necessary. 

12. Select Next. 

13. Add the desired field(s) you want to display in the query from the 
Available fields list box. 

14. Select Next. 

15. Type a name for the query. 

16. Select Finish. 

 



 

 

LESSON 7 -  
WORKING WITH THE OFFICE ASSISTANT  

In this lesson, you will learn how to: 

• Use the Office Assistant  

• Find an answer  

• Hide/Display the Office Assistant  

• Change Office Assistant options  
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USING THE OFFICE ASSISTANT 

 Discussion 
To assist you in quickly and efficiently getting comprehensive help on any Access 
feature, you can use the Office Assistant. The Office Assistant appears in the 
application window as an animated graphic with a balloon attached. The balloon 
contains shortcuts for accessing additional topics and tips. When you display the 
Office Assistant, the balloon automatically appears. In addition, the Office Assistant 
automatically provides tips and help on tasks as you work. The Office Assistant 
moves when it is in the way. 
 
The Office Assistant provides helpful hints called tips to help you get the most from 
Access. A typical tip might provide a keyboard combination that quickly displays a 
particular dialog box or a more efficient way to accomplish a task. You can click the 
Microsoft Access Help button to open the Office Assistant and view the tip. 
 
After you have read the tip, you can close it; however, tips are not available for all 
Access objects. In addition, if the topic you are looking for does not appear, you can 
ask for more help from the Web. 

 
The Office Assistant 
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If the Office Assistant is not displayed, you can activate it by 
selecting the Help menu and then selecting the Show the 
Office Assistant command. 

  

 
Once you have closed a tip, it does not appear again. To view 
a previous tip, you can select the Reset my tips button on the 
Options page in the Office Assistant dialog box. 

  
 

 Steps 

1. Click the light bulb that appears next to the Office Assistant. 

2. When you have finished viewing the tip, select OK. 

 

FINDING AN ANSWER 

 Discussion 
You can query the Office Assistant directly with any questions you may have 
regarding Access. When you query the Office Assistant, help topics related to your 
question appear. You can select any available help topic to view additional 
information. If there are more topics than can be displayed at one time, you can use 
the See more and the See previous commands to scroll through the available topics.  
 
The Office Assistant provides the best answers when you enter a complete sentence or 
question in a query, rather than just a word or phrase. For example, it is better to enter 
How do I open a form? rather than just forms. The last query remains in the Office 
Assistant until you create a new query or exit Access. 
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Finding an answer to a question 

 

 Steps 

1. Open the Office Assistant. 

2. Click the Office Assistant. 

3. Type the desired question or sentence. 

4. Select Search. 

5. Select the desired help topic. 

6. Click the Close button on the help window title bar. 

 

HIDING/DISPLAYING THE OFFICE ASSISTANT 

 Discussion 
You can display or hide the Office Assistant as desired. Hiding the Office Assistant 
removes it from view, but does not disable it. The Office Assistant continues to 
monitor your activities and, if it detects that you are using procedures that can be 
performed more efficiently, the Office Assistant button on the toolbar displays a light 
bulb, or it may appear automatically to offer assistance. 
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You may want to hide the Office Assistant if you are not using it, find it distracting, or 
require a larger working area. 
 

  

 
You can also hide the Office Assistant by clicking it with the 
right mouse button and selecting the Hide command. You can 
also permanently disable the Office Assistant by deselecting 
the Use the Office Assistant option in the Office Assistant 
dialog box. 

  

 
If the Office Assistant is enabled, but hidden, you can click the 
Microsoft Access Help button on the default toolbar to 
display it. 

   
 

 Steps 

1. Open the Office Assistant. 

2. Close the Microsoft Access dialog box. 

3. Select the Help menu. 

4. Select the Hide the Office Assistant or Show the Office Assistant 
command. 

 

CHANGING OFFICE ASSISTANT OPTIONS 

 Discussion 
You can use the options available on the Options page in the Office Assistant dialog 
box to make the Office Assistant work best for you. Some of these options are 
activated by default. 
 
The Office Assistant can be permanently disabled or enabled using the Use the Office 
Assistant option on the Options page in the Office Assistant dialog box. Under this 
heading, other options that can be selected include: Respond to F1 key, which opens 
the Office Assistant whenever you press the [F1] key; Move when in the way, which 
moves the Office Assistant as needed when screen elements (such as a dialog box) are 
open; and Guess help topics, in which the Office Assistant automatically displays 
help on the current task. 
 
Under Show tips about, you can choose exactly which type of tip you want to display 
or hide, depending upon your individual needs. You can choose to show or hide tips 
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about Using features more effectively, Using the mouse more effectively, and 
Keyboard shortcuts. 
 
In addition, you can select the following options: Only show high priority tips, 
which shows only important tips (such as time-saving tips); and Show the Tip of the 
Day at startup, which opens an Office Assistant tip each time Access starts. 
 
You can also reset your tips. This option allows you to review previous tips in the 
current Access session. This option does not affect other Office programs. 
 
Other Office programs, such as PowerPoint and Word, share the Office Assistant. 
Therefore, changes you make to the Office Assistant in Access affect all other Office 
programs. 
 
The Gallery page in the Office Assistant dialog box allows you to preview and select 
other Office Assistants. Additional Office Assistants can be downloaded from 
Microsoft’s Web page on the World Wide Web. 

 
The Options page 

 
  

 
You can right-click the Office Assistant and select the 
Options command to open the Office Assistant with the 
Options page displayed, or you can select the Choose 
Assistant command to open the Office Assistant dialog box 
with the Gallery page displayed. 
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If you have Internet access to the World Wide Web, you can 
select additional Office Assistants from Microsoft’s Web 
page. These Office Assistants are found by selecting the Help 
menu and then selecting the Office on the Web command. 

  

 
If you disable the Office Assistant, you can enable it by 
selecting the Help menu and then selecting the Show the 
Office Assistant command. 

  
 

 Steps 

1. Open the Office Assistant. 

2. Click the Office Assistant. 

3. Select Options. 

4. Select the Options tab. 

5. Select or deselect the desired options. 

6. Select OK. 

 





 

 

LESSON 8 -  
USING ONLINE HELP  

In this lesson, you will learn how to: 

• Work with online Help  

• View ScreenTips  

• Use Help Contents  

• Show and hide the help tabs  

• Use the Help Answer Wizard  

• Use the Help Index  
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WORKING WITH ONLINE HELP 

 Discussion 
If you need assistance on any Access topic or task, you can use Access’ extensive 
Help facility. There are several ways in which you can get help, all of which are 
available from the Help menu. One way is using the Microsoft Access Help 
command, which launches the Office Assistant if it is enabled. If the Office Assistant 
is disabled, you can directly access the Help window, which includes the Contents, 
Index, or Answer Wizard components. These components allow you to scroll through 
a table of contents, search for a specific word or phrase based on a keyword, or search 
based on a question you type. 
 
The What’s This? command can be used to display a ScreenTip. Pressing the [F1] 
key invokes context-sensitive Help. 
 
If you have World Wide Web access on the Internet, you can use the Office on the 
Web submenu to connect to web sites directly from Access. You can download free 
programs, access on-line support, and get the latest Microsoft product information 
from a web siteall without leaving Access. 
 
The Detect and Repair command reviews the previous install process and finds and 
fixes problems that may have developed during or since the initial software 
installation. The Detect and Repair feature cannot repair corrupted data files. 
 
You can use the About Microsoft Access command to view copyright and licensing 
information about the program. The About Microsoft Access window contains a 
System Info button that displays information about your computer and a Tech 
Support button that provides help on getting product support. 
 

  

 
You can disable the Office Assistant by deselecting the Use 
the Office Assistant option on the Options page in the Office 
Assistant dialog box. 

  
 

VIEWING SCREENTIPS 

 Discussion 
If you are unsure of the name and function of a menu command or any other item in a 
window, you can use a ScreenTip to view either the item name or a description of the 
item. You can access ScreenTips by selecting the What’s This? command from the 
Help menu. 
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ScreenTips for toolbars are activated by default, as long as you have enabled the 
option in the Customize dialog box. To view a ScreenTip for a toolbar button, you 
point to the desired toolbar button and the button name appears. 
 
When ScreenTips are activated, the mouse pointer appears with a question mark. 
 

  

 
You can also access ScreenTips by pressing the [Shift+F1] 
key combination and then pointing to and/or clicking the item 
for which you want help. 

  
 

 Steps 

1. Select the Help menu. 

2. Select the What’s This? command. 

3. Point to the button or item with which you want help. 

4. Click the button or item with which you want help. 

 

USING HELP CONTENTS 

 Discussion 
The Microsoft Access Help window, accessible from the Microsoft Access Help 
command on the Help menu when the Office Assistant is disabled, is comprised of 
two panes. The pane on the left contains the three help tabs: Contents, Answer 
Wizard, and Index. The pane on the right contains the information pertaining to the 
selected help topic. 
 
The Contents page displays a list of general help topics. From this list, you can select 
a help topic for a particular group of features or functions. This page is structured like 
a standard table of contents. The table is expandable; when you double-click a topic, 
related subtopics appear. When you select the help topic you want to view, it appears 
in the right pane of the help window. The underlined, colored text that appears in the 
right pane may be selected to display additional help topics. 
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Using Help Contents 

 
  

 
You can also expand help topics on the Contents page by 
clicking the plus sign (+) next to the desired topic. 

  
 

 Steps 

1. Disable the Office Assistant on the Options page in the Office 
Assistant dialog box, if necessary. 

2. Select the Help menu. 

3. Select the Microsoft Access Help command. 

4. Select the Contents tab. 

5. Select the desired topic. 

6. Select the desired subtopic. 
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SHOWING AND HIDING THE HELP TABS 

 Discussion 
When the Microsoft Access Help window is opened from the Help menu, it displays 
two panes: the tabs for the help components appear in the left pane and the 
information about the selected help topic appears in the right pane. 
 
You can hide the left pane or show both panes of the Microsoft Access Help window 
using the Show and Hide buttons at the top of the window. Hiding the help tabs in the 
left pane decreases the size of the help window. This option allows you to continue 
working in the Database window while you reference the selected help topic text in 
the right pane of the Microsoft Access Help window. 
 

  

 
When you select a help topic using the Office Assistant, only 
the right pane of the Microsoft Access Help window appears. 
You must use the Show button to access the Contents, 
Answer Wizard, and Index tabs. 

  

 
You can also show or hide the help tabs by selecting the Show 
Tabs or Hide Tabs commands from the Options button in the 
Microsoft Access Help window. 

  
 

 Steps 

1. Open the Microsoft Access Help window. 

2. Click the Hide button  at the top of the Microsoft Access Help 
window to hide the help tabs in the left pane. 

3. Click the Show button  at the top of the Microsoft Access Help 
window to display the help tabs in the left pane. 
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USING THE HELP ANSWER WIZARD 

 Discussion 
You can use the Answer Wizard page in the Microsoft Access Help window to 
quickly locate help topics based on questions you ask. The Answer Wizard page 
functions in much the same way as the Office Assistant. Any help topics that satisfy 
the typed question appear when you search using the Answer Wizard.  

 
Using the Help Answer Wizard 

 

 Steps 

1. Disable the Office Assistant on the Options page in the Office 
Assistant dialog box, if necessary. 

2. Select the Help menu. 
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3. Select the Microsoft Access Help command. 

4. Select the Answer Wizard tab. 

5. Type the question on which you want to base your search in the 
What would you like to do? text box. 

6. Select Search. 

7. Select the desired help topic in the Select topic to display list box. 

 

USING THE HELP INDEX 

 Discussion 
The Access Help system includes an alphabetical index of available help topics on the 
Index page in the Microsoft Access Help window. 
 
The Index page enables you to search for a topic using a keyword. When the keyword 
is typed into the Type keywords text box, an alphabetical index of available help 
topics appears. You then select the desired topic which then displays an additional list 
of subtopics. 
 
When entering search criteria containing more than one word, place an underline 
character between each word. For example, to search for a subject such as page 
break, you would type page_break in the Type keywords text box. 
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Using the Help Index 

 
  

 
If you want to perform another search on a different subject, 
select the Clear button to clear the previous search criteria and 
then enter the new search criteria. 

  
 

 Steps 

1. Disable the Office Assistant on the Options page in the Office 
Assistant dialog box, if necessary. 

2. Select the Help menu. 

3. Select the Microsoft Access Help command. 

4. Select the Index tab. 

5. Type the topic for which you want to search. 
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6. Select Search to search for the keyword(s) or double-click a topic 
from the Or choose keywords list box. 

7. Double-click the desired subtopic in the Choose a topic list box. 
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Append queries 

creating, 41, 42 
Calculated fields 

creating, 27, 28 
Comparison operators 

using, 18, 19 
Concatenation 

using in a query, 31, 32 
Conditions 

And, 20 
Or, 21, 22 

Crosstab queries 
creating, 46 

Crosstab Query Wizard 
using, 46, 47 

Datasheet view 
opening a query, 5, 6 

Delete queries 
creating, 42, 43 

Design view 
creating a query, 4, 5 

Fields 
hiding in a query, 14 

Find Duplicates Query Wizard 
using, 47, 48 

Find Unmatched Query Wizard 
using, 49 

Help 
hiding the tabs, 63 
showing the tabs, 63 
using Contents, 61, 62 
using the Answer Wizard, 64 
using the Index, 65, 66 
viewing ScreenTips, 60, 61 
working with, 60 

Make-table queries 
creating, 38 

Office Assistant 
changing options, 55, 57 
displaying, 54, 55 
finding an answer, 53, 54 
hiding, 54, 55 
using, 52, 53 

Operators 
And, 20 
Between And, 22, 23 
Or, 21, 22 
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Parameter queries 
creating, 30, 31 

Printing 
queries, 16 
RecordSets, 16 

Queries 
adding a table, 6, 7 
adding criteria, 13 
adding records, 14, 15 
append, 41, 42 
applying a filter, 34 
creating a calculated field, 27, 28 
creating in Design view, 4, 5 
creating with functions, 29 
crosstab, 46, 47 
delete, 42, 43 
filtering, 34 
grouping records, 29 
hiding a field, 14 
joining tables, 7, 8 
make-table, 38 
opening, 5, 6 
parameter, 30, 31 
printing, 16 
running, 9 
setting top values, 26, 27 
Simple Query Wizard, 2, 3 
sorting, 12 
update, 39, 40 
using, 2 
using a concatenation in, 31, 32 
using an And condition, 20 
using an Or condition, 21, 22 
using comparison operators, 18, 19 
using multiple tables in, 33 
using the Between And operator, 22, 23 
using wildcard characters, 23, 24 

Records 
adding to a query, 14, 15 

RecordSets 
printing, 16 
using, 2 

Relationships 
join types, 7, 8 

ScreenTips 
viewing, 60, 61 

Simple Query Wizard, 2, 3 
Tables 

adding to a query, 6, 7 
joining in a query, 7, 8 
using multiple in a query, 33 
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Update queries 
creating, 39, 40 

Wildcard characters 
using, 23, 24 

Wizards 
Crosstab Query, 46, 47 
Find Duplicates Query, 47, 48 
Find Unmatched Query, 49 
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please visit the Education and Training web site at: 
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or 
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